
Cloud Security Connector GRE Cluster 

with Private Cloud Private Access

(For Virtual Platforms: VMware, Hyper-V and KVM)

Version 4.1.0

April 2024



Table of Contents
1 Introduction to Cloud Security Connectors (CSC) for Zscaler............................................................7
2 Key benefits of the CSC GRE for Zscaler with PriCPA.........................................................................7
3 Network Diagrams.............................................................................................................................9

3.1 Cloud Security Connectors for Zscaler with PriCPA...................................................................9
3.2 Replacing a Secure Web Gateway appliance...........................................................................10
3.3 Information required to create the CSC GRE Cluster Form.....................................................11
3.4 Traffic Forwarding (I): Routed Mode........................................................................................12
3.5 Traffic Forwarding (II): Proxied Mode......................................................................................13
3.6 Traffic Forwarding (III): Routing and Proxying all together......................................................14
3.7 Private Cloud Private Access (PriCPA)......................................................................................15

4 Creating the CSC GRE Cluster..........................................................................................................16
4.1 Create Static IP, GRE Tunnel and Location on your Zscaler console........................................16

4.1.1 Static IP.............................................................................................................................16
4.1.2 GRE tunnel........................................................................................................................16
4.1.3 Create a Location..............................................................................................................18

4.2 Filling the form.........................................................................................................................19
4.2.1 General Information.........................................................................................................20
4.2.2 IP Addressing (Internal)....................................................................................................21
4.2.3 DNS servers......................................................................................................................22
4.2.4 External IP address...........................................................................................................23
4.2.5 GRE Tunnel Information...................................................................................................24

5 Firewall Requirements.....................................................................................................................25
5.1 NAT requirements....................................................................................................................25
5.2 Allow Rules required................................................................................................................26

5.2.1 Outbound Rules:..............................................................................................................26
5.2.2 Inbound Rules:.................................................................................................................26

6 Installing the OVA or Disk file in your Virtual Platform....................................................................27
6.1 Using VMware 5.x....................................................................................................................27
6.2 Using VMware 6.x....................................................................................................................28
6.3 Using Hyper-V..........................................................................................................................30
6.4 Using KVM................................................................................................................................33
6.5 VM sizing..................................................................................................................................37

7 Powering up the CSC GRE................................................................................................................38
8 Traffic forwarding to Zscaler ZIA and Bypasses...............................................................................40

8.1 Routing all traffic via the Cloud Security Connector................................................................40
8.2 Devices using PAC files or Zscaler Client Connector................................................................41
8.3 Devices using Explicit Proxy Settings.......................................................................................44
8.4 Special cases:...........................................................................................................................46

8.4.1 Using "Global ZEN IP Addresses" as Proxy IP...................................................................46
8.4.2 Using TCP port 8080.........................................................................................................46

9 Testing traffic to Zscaler and Bypass................................................................................................47
9.1 To Zscaler traffic test................................................................................................................48

Maidenhead Bridge CSC GRE for Zscaler - Virtual Platforms  | 2



9.1.1 Using a browser................................................................................................................48
9.1.2 Using Curl Command via CMD.........................................................................................49

9.2 Bypass Traffic test.....................................................................................................................49
9.2.1 Using a Browser................................................................................................................49
9.2.2 Using Curl Command via CMD.........................................................................................50

9.3 Speed test................................................................................................................................50
10 The Cloud Security Connector Admin Console:.............................................................................51

10.1 Monitoring Tasks....................................................................................................................53
10.1.1 Show Configuration and Status (TBC)............................................................................53

10.1.1.1  GENERAL INFORMATION.......................................................................................54
10.1.1.2  INTERFACES INFORMATION...................................................................................54
10.1.1.3  TRAFFIC REDIRECTION Options.............................................................................54
10.1.1.4  DNS INFORMATION...............................................................................................55
10.1.1.5  ZSCALER INFORMATION........................................................................................55
10.1.1.6  TUNNEL STATUS.....................................................................................................55
10.1.1.7  http://ip.zscaler.com INFORMATION.....................................................................55
10.1.1.8  PROXY BYPASS........................................................................................................56
10.1.1.9  ROUTED BYPASS.....................................................................................................56
10.1.1.10  AWS SSM AGENT.................................................................................................56
10.1.1.11  SYSLOG INFORMATION........................................................................................56

10.1.1.11.1 System Logs example:...................................................................................57
10.1.1.11.2 Traffic Logs example:....................................................................................57

10.1.1.12  HIGH AVAILABILITY Information..........................................................................58
10.1.2 Show Interfaces Traffic...................................................................................................59
10.1.3 Tcpdump, Traceroute and Latency Test..........................................................................59

10.1.3.1  Tcpdump................................................................................................................59
10.1.3.2  Traceroute and Latency Test..................................................................................61

10.1.4 SPEED TEST.....................................................................................................................61
10.2 CSC Admin Tasks....................................................................................................................62

10.2.1 AWS SSM Agent (Register or De-Register).....................................................................62
10.2.1.1  Create a "Hybrid Activation" from AWS console...................................................62
10.2.1.2  Register the CSCs...................................................................................................63
10.2.1.3  View the Registered CSC on AWS Systems Manager............................................63

10.2.2 Manage Administrators, Restrict SSH access and Radius Configuration.......................64
10.2.2.1  Manage Administrators: cscadmin and csccli.......................................................64

10.2.2.1.1 "cscadmin" settings........................................................................................64
10.2.2.1.2 "csccli" settings...............................................................................................65
10.2.2.1.3 Managing the SSH Key of a User....................................................................65

10.2.2.2  Restrict SSH Access................................................................................................65
10.2.2.3  Radius Configuration.............................................................................................67

10.2.3 Configure DNS, SNMP, NTP and Timezone.....................................................................69
10.2.3.1  DNS........................................................................................................................69
10.2.3.2  SNMP.....................................................................................................................69

10.2.3.2.1 Configure SNMP attributes.............................................................................69

Maidenhead Bridge CSC GRE for Zscaler - Virtual Platforms  | 3



10.2.3.2.2 SNMP v2c configuration.................................................................................70
10.2.3.2.3 SNMP Networks..............................................................................................70
10.2.3.2.4 SNMP v3 configuration...................................................................................71
10.2.3.2.5 What can you do with SNMP?........................................................................72

10.2.3.2.5.1 Node Information...................................................................................72
10.2.3.2.5.2 Node Availability.....................................................................................72
10.2.3.2.5.3 Node Interfaces (IP & SNMP)..................................................................73
10.2.3.2.5.4 Node Statistics (CPU, Memory, etc)........................................................73
10.2.3.2.5.5 Interfaces Traffic......................................................................................74

10.2.3.3  NTP........................................................................................................................75
10.2.3.4  Time Zone..............................................................................................................75

10.3 Proxy Bypass..........................................................................................................................77
10.3.1 Standard Mode..............................................................................................................77

10.3.1.1  Network Diagram..................................................................................................77
10.3.1.2  Configuration using PAC file..................................................................................77
10.3.1.3  Manual Configuration............................................................................................78
10.3.1.4  "View Current Proxy Bypass List"..........................................................................80

10.3.2 Advanced Mode.............................................................................................................81
10.3.2.1  Network Diagram..................................................................................................81
10.3.2.2  Configuration using JSON URL...............................................................................81
10.3.2.3  Configuration pasting JSON file.............................................................................83
10.3.2.4  "View Current Proxy Bypass List"..........................................................................84

10.4 Routed Bypass........................................................................................................................85
10.4.1 Routed Bypass - Traffic Flow..........................................................................................85
10.4.2 View Current Routed Bypass List...................................................................................85

10.4.2.1  Compact................................................................................................................86
10.4.2.2  Json........................................................................................................................86

10.4.3 Configure Routed Bypass List.........................................................................................87
10.4.3.1  Routed Bypass URL................................................................................................87
10.4.3.2  Manual (Paste Routed Bypass JSON file)...............................................................88

10.5 System and Traffic Logs..........................................................................................................89
10.5.1 View System Logs...........................................................................................................89
10.5.2 Configure Syslog and Traffic Logs...................................................................................89

10.6 Configuration Wizards............................................................................................................90
10.6.1 Configure Zscaler Nodes and GRE values.......................................................................90
10.6.2 Switch Tunnels - Primary / Secondary............................................................................91

11 Private Cloud Private Access..........................................................................................................92
11.1 What is Private Cloud Private Access (PriCPA)?.....................................................................92
11.2 PriCPA Network Diagrams......................................................................................................92

11.2.1 High Level Network Diagram..........................................................................................92
11.2.2 Low Level Network Diagram – PriCPA only....................................................................93

11.3 Configuring PriCPA.................................................................................................................94
11.3.1 Create the Local configuration (First node of the HA pair)............................................94
11.3.2 Create the Local configuration (second node of HA Pair)..............................................95

Maidenhead Bridge CSC GRE for Zscaler - Virtual Platforms  | 4



11.3.3 Create the Private Access Peers JSON file......................................................................97
11.3.3.1  Full mesh Private Access Peers JSON file...............................................................97
11.3.3.2  Understanding "privateApps" configuration and values.....................................102
11.3.3.3  Example of "privateApps" for a Windows Domain controller.............................104
11.3.3.4  Example of "privateApps" for Internal Web Server.............................................104

11.3.4 Load the "Private Access Peers JSON file" to the CSCs................................................105
11.3.4.1  Using "Private Access Peers URL"........................................................................105
11.3.4.2  Manual: Copy and Paste "Private Access Peers Json file"...................................110

11.4 Show Configurations and Status Private Access..................................................................111
11.4.1 Using SSH Admin console.............................................................................................111

11.4.1.1  Show Peer/s Status..............................................................................................111
11.4.1.2  Show Peers Json file (active)...............................................................................112
11.4.1.3  Show Local Configuration....................................................................................114
11.4.1.4  Show Firewall Local Rules....................................................................................114

11.4.2 Using AWS Systems Manager or Rundeck...................................................................115
11.4.2.1  AWS Systems Manager........................................................................................115
11.4.2.2  Rundeck...............................................................................................................115

11.5 Configure CSC Remote Management via Private Access.....................................................116
12 Remote Management..................................................................................................................117

12.1 AWS Systems Manager........................................................................................................118
12.1.1 Create Documents........................................................................................................118
12.1.2 Run Commands............................................................................................................119
12.1.3 List of Documents available for "Run Command"........................................................123

12.2 Rundeck...............................................................................................................................124
12.2.1 Jobs...............................................................................................................................125
12.2.2 Running job "Show Configuration and Status"............................................................125

13 DevOps operations......................................................................................................................126
13.1 routedBypassRulesFile.json.................................................................................................127
13.2 privateAccessPeersConfig.json............................................................................................129

14 Appendixes..................................................................................................................................131
14.1 Appendix A: Release Notes..................................................................................................131

14.1.1 Version 4.1.0................................................................................................................131
14.1.2 Version 4.0.5................................................................................................................131
14.1.3 Version 2.6....................................................................................................................132
14.1.4 Version 2.5....................................................................................................................132
14.1.5 Version 2.3....................................................................................................................132
14.1.6 Version 2.2....................................................................................................................132
14.1.7 Version 2.1....................................................................................................................133
14.1.8 Version 2.0....................................................................................................................133

14.2 Appendix B: JSON formatters (Visual Code, Notepad ++)...................................................135
14.2.1 Visual Code...................................................................................................................135
14.2.2 Notepad ++...................................................................................................................136

14.3 Appendix C: Securing an AWS Bucket by source IP..............................................................138

Maidenhead Bridge CSC GRE for Zscaler - Virtual Platforms  | 5



Maidenhead Bridge CSC GRE for Zscaler - Virtual Platforms  | 6



1 Introduction to Cloud Security Connectors (CSC) for Zscaler.
The Cloud Security Connector (CSC) is a device that enables easy deployments of the Zscaler 
Internet Access (ZIA) solution in any customer environment. 

The CSC's GRE Cluster lets you connect securely to Zscaler ZIA up to 3 Gbps without hassle.

The primary purpose of the CSC GRE family is simplicity: You don't need to re-architect your 
network. The CSC GRE is a direct replacement for your current Web Security Appliance. You can 
place the CSC GRE on the same network segment that your existing appliance and the CSC will 
redirect the traffic to Zscaler ZIA.

No configuration is required. Simply filling a form with your IP addressing, download the CSC (VM) 
and power it on.

The CSC GRE comes with all parameters to work with Zscaler ZIA. As soon you lunch the CSC at the 
location, the CSC will automatically connect to the best Zscaler ZIA nodes. The CSC GRE contains 
the perfect configuration for GRE tunnels, firewall rules and routing tables that are necessary.

You can run the CSC GRE on any virtual software: Vmware, Hyper-V, KVM, Etc, and a hardware 
version is also available on request.

All Zscaler ZIA functionalities are available. Internal IPs are completely visible on the Zscaler 
console GUI.

Includes Private Cloud Private Access functionality that allows you to create a full mesh among the 
CSCs communicating your private traffic on a Zero Trust model.

Simple to install with complete management from Amazon AWS, Rundeck (or similar, like Ansible, 
Salt, Etc.) and SSH.

2 Key benefits of the CSC GRE for Zscaler with PriCPA
• No Networking knowledge is required. 

• The CSC is a direct replacement for your current legacy Web Security Appliance.

• Enables any Location to be connected to Zscaler ZIA up to 3 Gbps.

• Easy to create: Filling a form indicating your IPs and GWs. 

• Easy to deploy: Deploy OVA file setting the External and the Internal interface. 

• With Private Cloud Private Access (PriCPA) you can connect all sites securely on a Zero Trust
model. The CSC secures your Private Traffic between your physical and cloud locations. 

• The CSC comes with the optimal values to work with Zscaler ZIA.
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• Full tunnel redundancy.

• High Availability.

• All traffic forwarding options supported:

◦ Route all traffic to Zscaler (or http/s only).

◦ Use of PAC files.

◦ Use of Explicit Proxy.

◦ No default Route scenarios.

• Multiple options to Bypass Traffic via dedicated Public IP:

◦ Layer 7 Proxy Bypass to Trusted Web Sites.

◦ Layer 4 Routed Bypass: TCP, UDP and ICMP per source/destination Network and Port 
(UDP/TCP)

• New! Full Proxy mode for devices with Explicit Proxy settings (i.e. Linux hosts), enabling 
communications to Zscaler (Location IP based), direct domain Bypass (ie. .domain.com) and
communication with internal systems. 

• Zscaler Cloud Firewall and Cloud Web Security.

• Complete visibility of internal IPs on Zscaler Console. 

• No operational burden for Administrators.

• Full hardened device.

• Works behind a NAT.

• All virtual platforms supported: Vmware, Hyper-V, KVM, Etc. Hardware version available if 
required.

• Multiple tools for testing and troubleshooting included: Traffic Logs. TCPDump, Speed Test, 
MTR (MyTraceRoute), Keepalives statuses, Etc. 

• Allow the internal communication between your locations with Private Cloud Private 
Access.

• Management via SSH, AWS Systems Manager, Rundeck or similar. (Ansible, Salt, Etc.)

• Small OVA instance: 2 CPU, 4 GB RAM, 16 GB Disk
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3 Network Diagrams

3.1 Cloud Security Connectors for Zscaler with PriCPA.
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3.2 Replacing a Secure Web Gateway appliance
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3.3 Information required to create the CSC GRE Cluster Form
Please, contact sales@maidenheadbridge.com to obtain the link to the form. 
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3.4 Traffic Forwarding (I): Routed Mode.
The most significant benefit of the Cloud Security Connector for Zscaler is that it covers all possible scenarios (routed traffic, PAC files, explicit proxy, 
etc..) for any device in your organization: Laptops, Desktops, Servers, IoT devices, Virtual Desktops, Linux servers, Etc. 
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3.5 Traffic Forwarding (II): Proxied Mode.
The most significant benefit of the Cloud Security Connector for Zscaler is that it covers all possible scenarios (routed traffic, PAC files, explicit proxy, 
etc..) for any device in your organization: Laptops, Desktops, Servers, IoT devices, Virtual Desktops, Linux servers, Etc. 
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3.6 Traffic Forwarding (III): Routing and Proxying all together.
The most significant benefit of the Cloud Security Connector for Zscaler is that it covers all possible scenarios (routed traffic, PAC files, explicit proxy, 
etc..) for any device in your organization: Laptops, Desktops, Servers, IoT devices, Virtual Desktops, Linux servers, Etc. 

The function of each internal IP is the follwing:

IP Type Function

CSC GW Gateway It is used as a Gateway when routing traffic to Zscaler and bypasses using the "Routed Bypass" (Layer 4) functionality.

CSC Vip Proxy Proxy It is used as a Proxy for traffic to Zscaler via the GRE tunnel. (1 Gbps up to 3 Gbps)

CSC Proxy Bypass Proxy Standard Mode: It is used as a Proxy for bypasses using "Proxy Bypass" (Layer 7) functionality. 
Advanced Mode: Same as Standard Mode, but all traffic not in the bypass list is sent to Zscaler (via Location IP, 300 Mbps). Advanced 
Mode is recommended for devices or apps supporting Explicit Proxy Settings but not PAC files—for example, Linux Servers. Additionally, 
it is possible to reach internal corporate sites.
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3.7 Private Cloud Private Access (PriCPA)
Private Cloud Private Access functionality allows you to create a full mesh among the CSCs communicating your private traffic on a Zero Trust model.
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4 Creating the CSC GRE Cluster
To create the CSC GRE is very easy. You must complete a form with your IP addresses and the GRE 
tunnel information.

4.1 Create Static IP, GRE Tunnel and Location on your Zscaler
console.

4.1.1 Static IP
Go to Administration -> Static IP -> Static IPs & GRE Tunnels and "Add Static IP"

➢ Click "Next", "Next" and "Save"

4.1.2 GRE tunnel
Go to Administration -> Static IP -> Static IPs & GRE Tunnels and "Add GRE tunnel"

➢ Click "Next"
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➢ Select Primary and Secondary Data Center VIP and Click "Next"

➢ Click "Next", see Review and "Save"
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4.1.3 Create a Location
Go to Administration -> Location Management -> and "Add Location"

➢ Click "Save" and "Activation".

Maidenhead Bridge CSC GRE for Zscaler - Virtual Platforms  | 18



4.2 Filling the form
After you buy the CSC, you will receive a welcome email indicating that you must fill out the form 
with your data. 
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4.2.1 General Information

Maidenhead Bridge CSC GRE for Zscaler - Virtual Platforms  | 20



4.2.2 IP Addressing (Internal)
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4.2.3 DNS servers

➢ Click "Next"
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4.2.4 External IP address

➢ Click "Next"
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4.2.5 GRE Tunnel Information

➢ Click "Submit"

Important: After filling out the form, you will receive the URL links to download the CSC VM 
images in the format you selected: VMware (OVA), HyperV (.vhdx disk) or KVM (qcow2 disk)
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5 Firewall Requirements
The CSC GRE Cluster uses four IPs on the external interface, and it is required to set up specific NAT
and Allow Rules in your Firewall for all of them.

The following table shows the name and purpose of each one. 

External IP# Name Purpose

First GRE Tunnel IP Source IP of the GRE Tunnel

Second Bypass Egress IP & PriCPA Source IP of the Routed Bypass, Proxied Bypass and PriCPA.

Third  CSC IP(eth0) -a External IP of the VM -a

Fourth  CSC IP(eth0) -b External IP of the VM -b

5.1 NAT requirements
External IP# Name NAT Type required: via Public IP

First GRE Tunnel IP STATIC (also called 1:1 NAT) 1 The GRE Public “Static IP” configured on the 
Zscaler Console.

Second Bypass Egress IP STATIC2 or DYNAMIC.  Any Public IP - This will be your "Source Public 
IP"3 when reaching Trusted Sites and connecting 
other Locations when using PriCPA 

Third  CSC IP(eth0) -a DYNAMIC (also called 1:N  NAT) Any Public IP

Fourth  CSC IP(eth0) -b DYNAMIC (also called 1:N  NAT) Any Public IP

1 Some firewall may require a dedicated IP when the protocol is GRE.
2 When using Private Access, it is advisable to use Static Nat to avoid changing the packet's Source Port.
3 Be sure that you are Natting the  "Bypass Egress IP" via the Public IP configured on your "Trusted sites". 
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5.2 Allow Rules required

5.2.1 Outbound Rules:
The following table shows the allow rules required.

External IP# Source Protocol Ports / Service Destination

First GRE Tunnel IP GRE (47) None.(4) Zscaler Primary and Secondary GRE 
destinations

Second Bypass Egress IP & 
Pricpa

TCP, UDP UDP: 51820 
TCP:80, 443 or 
Any (5)

Internet (or specific rules to: Trusted 
Destinations and PriCPA Nodes (6))

Third  CSC IP(eth0) -a 
 CSC IP(eth0) -b

ICMP echo-request FW Gateway (7) and  Zscaler Nodes SME 
[Proxy Hostname] IPs (Adv. Bypass)

Fourth TCP 80, 443, 9480 Internet (or specific rules to: Zscaler 
Nodes SME [Proxy Hostname] IPs (8), AWS
Systems Manager (9), Others (10))

UDP (11l), NTP 53, 123 Public DNS servers, Ubuntu NTP

5.2.2 Inbound Rules:
External IP# Destination Protocol Ports / Service Source

First GRE Tunnel IP n/a n/a n/a

Second Bypass Egress IP & 
Pricpa

UDP Any (default 51820) PriCPA Nodes. (12) 

Third  CSC IP(eth0) -a 
 CSC IP(eth0) -b

ICMP (13) echo-reply
time-exceeded

Zscaler Primary and Secondary GRE 
destinations

Fourth

4 GRE is protocol and has not ports.
5 If you want to be specific with TCP and UDP ports, note the following: Proxy Bypass requires port TCP 80/443, but 

sometimes high TCP ports are required; for example, a URL: www.domain.com:5050 will need TCP port 5050 
enabled.  Routed Bypass can bypass any UDP/TCP port.  PriCPA default UDP port is 51820, but you can choose 
another port. In all cases, the CSC does specific outbound rules internally. Specifying outbound rules in your FW 
will result in a “double FW wall”. 

6 See PriCPA Local Firewall JSON file outbound rules for details. 
7 The CSC GRE Cluster pings the Gateway IP of the Firewall to check reachability. 
8 Zscaler Node SME [Proxy Hostname] IP can differ from Node GRE IP. Check page https://ips.<cloudname>.net -> 

Proxy Hostname and do 'nslookup <nodeName>.sme.<cloudName>.net' to obtain the IP.  
9 When using AWS SSM Agent, allow HTTPS from the csc-external-a (-b) to AWS. The AWS destinations are: 

ssm.<AWS region>.amazonaws.com, ec2messages.<AWS region>.amazonaws.com
10 The CSC retrieves the Proxy PAC URL, Routed JSON URL and the Private Access JSON URL via csc-external-a (-b). 
11 (Optional) this rule is required if you are using Public DNS servers, like 8.8.8.8 or 8.8.4.4. 
12 See PriCPA Local Firewall JSON file inbound rules for details. 
13 This rule is optional. This rule is required when doing the MyTraceRoute Test to see the values of intermediate 

hops in transit between the CSC and the Zscaler node.
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6 Installing the OVA or Disk file in your Virtual Platform.
The following examples shows the installation on Vmware, Hyper-V and KVM. 

6.1 Using VMware 5.x
1. Go to vSphere, File > Deploy OVF template

2. Select the OVA File:

3. OVF Template Details: Click Next

4. Name and Location: Put the Name you want.

5. Resource Pool: Place the VM where you want.

6. Disk Format: Click Next

7. Network Mapping: Please map the interfaces EXTERNAL and INTERNAL to your 
interfaces.  Here an example:

8. Click "Next"

9. Click "Finish"
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6.2 Using VMware 6.x
1. Go to Virtual Machines → Create/Register VM

2. Deploy a virtual machine from an OVF or OVA file

3. Click "Next"

4. Put a "Name" and "Select the OVA File"

5. Click "Next"

6. Select Storage and click Next

7. On "Deployment options", Select:
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a) "Network Mappings" → Select "EXTERNAL" and "INTERNAL" interfaces of the CSC.

b) Disk Provisioning: Thin

c) Power on Automatically

8. Click "Next"

9. The next screen will show all values:

10. Click "Finish"
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6.3 Using Hyper-V

Before to start: You will receive the CSC disk (.vhdx) on zip format. Please unzip it and place it on 
your Virtual Machine directory before to start this wizard. 

1. Go to Hyper-V and Click → Action → New

2. Click Next > and Specify Name and Storage

3. Click Next > Select "Generation 1" 
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4. Click Next > Assign Memory: 4096 MB

5. Click Next > Configure Networking 

IMPORTANT: This is the EXTERNAL interface of the CSC. We are going to add the Internal Interface 
later.
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6. Click Next > Connect Virtual Hard Disk  

Select the unzipped disk on "Use an existing virtual disk"

7. Click Next > Summary > Finish . 

The machine will be created but we need to add the INTERNAL Interface.

8. Right Click the machine created > Settings > Add Hardware > Network Adapter

9. Click Add > and connect it to your INTERNAL virtual switch
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10. Click Apply and OK.

6.4 Using KVM
When using KVM, you will receive the disks of the CSC GRE Cluster in qcow2 format. 

The following example shows the installation on a KVM server using Virtual Machine Manager 
(VMM)

1. Go to New -> Create a new Virtual Machine and select "Import existing disk image"
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2. Click "Forward"

3. Browse for the Disk and select Ubuntu 22.04 (or another Ubuntu version if 22.04 is not 
available) 

4. Click Forward.
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5. Select 2 x CPU and 4 GB Memory (or more).

6. Click Forward.

7. Put the Name of the CSC, Select "Customise configuration before install" and choose here 
the External Interface.
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8. Click Finish. 

9. We need to add now the Hardware for the Internal Interface.  Click "Add Hardware", select 
"Network" and on Network Source choose the Internal Interface of the CSC.

10. Click Finish.

11. The last step is: "Begin Installation"

12. Done! Repeat the same process for the other CSC. 
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6.5 VM sizing
The CSC is a very efficient device and consumes few CPU and RAM resources. By default, we ship it 
with 2 x CPU, 4 x GB RAM and 16 GB disk. If you are going to have an intensive use of Proxy Bypass 
and high PriCPA traffic, please increase CPU to 4 and RAM to 8 GB.
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7 Powering up the CSC GRE
1. Power on the Virtual Machines.

2. SSH to the CSC using : ssh cscadmin@< CSC IP(eth1) -a > or <  CSC IP(eth1) -b >. On the CSC 
GRE Cluster  CSC IP(eth1) -a is the fourth internal IP and  CSC IP(eth1) -b is the fifth. 

When prompted, put the following username and password to login on the CSC Console:

Username: cscadmin

Password: maidenheadbridge

Note: SSH to the EXTERNAL interface IPs is not allowed. 
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Select 1) Show Configuration and Status and Check Tunnel Status. 

Congratulations! You are connected to Zscaler. 

Please, take note of the values of CSC GW IP, VIP Proxy and Bypass Proxy. 

In the next chapter, we are going to discuss the multiple options of traffic redirection to Zscaler via 
the CSC GRE Cluster. 
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8 Traffic forwarding to Zscaler ZIA and Bypasses.
In Chapter 3 of this Administrator Guide, we showed the Network Diagrams of different scenarios 
of traffic forwarding and bypass traffic. In this chapter, we are going to dig into more detail about 
the configuration required.

We are going to analyse the following scenarios scenarios:
1. Routing all traffic via the Cloud Security Connector. 
2. Using PAC files and/or Zscaler Client Connector
3. Using Explicit Proxy Settings
4. Special Cases: Using "Zscaler Global ZEN" and using proxy port tcp/8080. 

8.1 Routing all traffic via the Cloud Security Connector
Network Diagram:

Setup:

This scenario is very simple to setup. The only task is to setup the default route to the internet 
(0.0.0.0/0) via the CSC GW IP.

Traffic to Zscaler:

By default, all traffic will be via the GRE tunnel to Zscaler ZIA, and you can enable all Zscaler 
functionalities: Zscaler Cloud Firewall, Secure Web Gateway, etc.

Routed Bypass traffic:

You can bypass traffic by combining Source / Destination IP, Protocol (TCP, UDP, ICMP) and Port. 
Common destinations to bypass are Teams/Skype UDP real-time traffic and Windows Login 
destinations for conditional access rules. (See Routed Bypass Configuration in the specific section 
of this guide. )
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8.2 Devices using PAC files or Zscaler Client Connector
Network Diagram:

Setup:

Devices with PAC Files: Distribute the PAC file URL via GPO.

PAC Example:

function FindProxyForURL(url, host) {
    // =========================================================
    // Section 1: Zscaler standard PAC values
    var privateIP = /^(0|10|127|192\.168|172\.1[6789]|172\.2[0-9]|172\.3[01]|169\.254|192\.88\.99)\.[0-9.]+$/;
    var resolved_ip = dnsResolve(host);

    /* Don't send non-FQDN or private IP auths to us */
    if (isPlainHostName(host) || isInNet(resolved_ip, "192.0.2.0", "255.255.255.0") || privateIP.test(resolved_ip))
        return "DIRECT";

    /* FTP goes directly */
    if (url.substring(0, 4) == "ftp:")
        return "DIRECT";

    /* test with ZPA */
    if (isInNet(resolved_ip, "100.64.0.0", "255.255.0.0"))
        return "DIRECT";

    // =========================================================
    // Section 2: Variables (CSC VIP: 10.2.2.13, CSC Bypass: 10.2.2.14)
    var tozscaler = "PROXY 10.2.2.13:80";
    var bypassproxy = "PROXY 10.2.2.14:3128";

    // =========================================================
    // Section 3: Bypass via Cloud Security Connectors

    // Bypass via CSC Public IPs (Examples)
    // Okta conditional access
    if ((shExpMatch(host, "*.okta.com")) ||
        (shExpMatch(host, "*.oktacdn.com")) ||
        (shExpMatch(host, "*.okta-emea.com")) ||
        (shExpMatch(host, "login.myOktaDomain.com")) ||
        // O365 Domains for ConditionalAccess
        (shExpMatch(host, "login.microsoftonline.com")) ||
        (shExpMatch(host, "login.microsoft.com")) ||
        (shExpMatch(host, "login.windows.net")) ||
        // My Trusted Sites
        (shExpMatch(host, "*.trustedSite-1.com")) ||
        (shExpMatch(host, "www.trustedSite-2.com")) ||
        // IP Test Page
        (shExpMatch(host, "ip.maidenheadbridge.com"))) {
        return bypassproxy;
    }
    // =========================================================
    // Section 4: Default Traffic
    /* Default Traffic Forwarding. Forwarding to Zen on port 80, but you can use port 9400 also */
    return tozscaler;
}
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Devices with Zscaler Client Connector (ZCC): 

1) Configure "Forwarding Profile" (Tunnel & Local Proxy) with a PAC file with the bypasses 
and point it to the CSC Proxy Bypass IP (return <CSC Proxy Bypass IP:3128>. 

PAC for ZCC "Forwarding Profile"

Same PAC than for Devices, but changing the variable "tozscaler"

   // =========================================================
    // Section 2: Variables (CSC Bypass: 10.2.2.14)
    var tozscaler =  "PROXY ${ZAPP_LOCAL_PROXY}"
    var bypassproxy = "PROXY 10.2.2.14:3128";

    // =========================================================

2) Configure "APP profile" with the "Forwarding Profile" and create a "Custom PAC" 
pointing the ZCC tunnel to the CSC VIP Proxy IP. (return <CSC VIP Proxy IP>:80 or 9400).

"Custom PAC" for ZCC "APP Profile" 

Same than PAC for Devices, but removing Bypasses - Section 3, variable "bypassproxy", and adding public Zscaler Nodes to the variable "tozscaler" 
(OFF Corporate network condition)

 function FindProxyForURL(url, host) {
    // =========================================================
    // Section 1: Zscaler standard PAC values
    var privateIP = /^(0|10|127|192\.168|172\.1[6789]|172\.2[0-9]|172\.3[01]|169\.254|192\.88\.99)\.[0-9.]+$/;
    var resolved_ip = dnsResolve(host);

    /* Don't send non-FQDN or private IP auths to us */
    if (isPlainHostName(host) || isInNet(resolved_ip, "192.0.2.0", "255.255.255.0") || privateIP.test(resolved_ip))
        return "DIRECT";

    /* FTP goes directly */
    if (url.substring(0, 4) == "ftp:")
        return "DIRECT";

    /* test with ZPA */
    if (isInNet(resolved_ip, "100.64.0.0", "255.255.0.0"))
        return "DIRECT";

    // =========================================================
    // Section 2: Variables (CSC VIP: 10.2.2.13, off Corporate Network use Zscaler Public Nodes)
    var tozscaler = "PROXY 10.2.2.13:80; PROXY ${GATEWAY}:80; PROXY ${SECONDARY_GATEWAY}:80; DIRECT";

    // =========================================================
    // Section 4: Default Traffic
    /* Default Traffic Forwarding. Forwarding to Zen on port 80, but you can use port 9400 also */
    return tozscaler;
}
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Traffic to Zscaler:

Devices with PAC Files:  The default traffic will go via the CSC VIP.
Devices with Zscaler Client Connector (ZCC):  The ZCC tunnel points to the CSC VIP (On Corporate 
Network). When the user is OFF Corporate Network, the tunnel will connect to the Zscaler Public 
Node. 

Proxied Bypass traffic:

Devices with PAC Files:  The host domains configured on the proxy bypass list will hit the CSC Proxy
Bypass IP, and the CSC will allow them to go directly to the Internet. Note that you need to 
configure the PAC URL on the CSC. (See Proxied Bypass Configuration in the specific section of this 
guide. )
Devices with Zscaler Client Connector (ZCC):  Same than previous. 
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8.3 Devices using Explicit Proxy Settings
Network Diagram:

Setup:

On the CSC, you need to enable: "Proxy Bypass Advanced Mode" and create a "Location IP" on 
your Zscaler console using the public IP that is natting the "CSC IP(eth0) (-a and -b)" of each CSC 
(See FW rules section). On the "Location IP," enable "Use XFF from Client Request" to ensure the 
complete visibility of internal IPs. Also, you need to set the CSC's bypass list with the domains you 
want to send directly to the Internet and, if required, internal domains.

The configuration of the CSC is via JSON file. You can host the JSON file and setup the URL on the 
CSC, or you can paste the JSON file on the CSC. 

Advanced Mode JSON file

{
  "model": "csc-gre-zs-vm",
  "type": "proxyBypassAdvanced",
  "version": "1.0",
  "help": ".domain.com matches domain.com and any subdomain of <>.domain.com. Do not use asterisk '*'",
  "proxyBypassRules": {
    "internalSites": [
      ".domainInternal.com",
      "fqdn-internal.com"
    ],
    "externalSites": [
      ".externalDomain.com",
      "fqdn-external.com",
      "ip.maidenheadbridge.com",
      "ipinfo.io"
    ]
  }
}
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On your devices, you need to setup the explicit Proxy for HTTP and HTTPS traffic. For example, in a 
Linux Server is:

Settings Variables for http, https and no_proxy14

export15 http_proxy=http://<CSC Proxy Bypass IP>:3128
export https_proxy=http://<CSC Proxy Bypass IP>:3128
export no_proxy= <your local domains>16

Traffic to Zscaler:

By default, the CSC will send all destination domains not in the bypass list to Zscaler.

Proxied Bypass traffic:

Domains in the bypass list will be routed externally or internally according the DNS resolution. 

14 Add this lines to "/etc/environment" to make this changes permanent. 
15 Use command $unset <variable name> to clear the values.
16 IF "no_proxy" variable is blank, we sure to add your internal domains on the CSC bypass list.  
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8.4 Special cases: 

8.4.1 Using "Global ZEN IP Addresses" as Proxy IP
The CSC can intercept the "Global ZEN IP Addresses" when this destination is routed via the CSC 
GW IP. If the destination port is 80/9400, the traffic will travel via the GRE tunnel to Zscaler. If the 
destination port is 3128, the traffic will be sent to the Proxy Bypass. 

This method is commonly used in "no default route to the internet" scenarios. 

8.4.2 Using TCP port 8080.
Zscaler (ZIA) Public Service Edges accept web requests on ports 80, 443, 9400, 9480, and 9443 but 
not in port 8080.

The CSC provides support for port tcp/8080. You can use proxy: <CSC VIP Proxy>:8080 or <Global 
Zen IP Address>:8080 and the CSC will convert to a port accepted by Zscaler ZIA.

If you have hardcoded or configured your proxy settings with port 8080, the CSC is the solution to 
the above mentioned problem.
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9 Testing traffic to Zscaler and Bypass
The following test is using a Windows PC, with the following PAC file:

Test PAC file

function FindProxyForURL(url, host) {
    // =========================================================
    // Section 1: Zscaler standard PAC values
    var privateIP = /^(0|10|127|192\.168|172\.1[6789]|172\.2[0-9]|172\.3[01]|169\.254|192\.88\.99)\.[0-9.]+$/;
    var resolved_ip = dnsResolve(host);

    /* Don't send non-FQDN or private IP auths to us */
    if (isPlainHostName(host) || isInNet(resolved_ip, "192.0.2.0", "255.255.255.0") || privateIP.test(resolved_ip))
        return "DIRECT";

    /* FTP goes directly */
    if (url.substring(0, 4) == "ftp:")
        return "DIRECT";

    /* test with ZPA */
    if (isInNet(resolved_ip, "100.64.0.0", "255.255.0.0"))
        return "DIRECT";

    // =========================================================
    // Section 2: Variables (CSC VIP: 172.19.0.61, CSC Bypass: 172.19.0.62)
    var tozscaler = "PROXY 172.19.0.61:80";
    var bypassproxy = "PROXY 172.19.0.62:3128";

    // =========================================================
    // Section 3: Bypass via Cloud Security Connectors

    // O365 Domains for ConditionalAccess
    if ((shExpMatch(host, "login.microsoftonline.com")) ||
        (shExpMatch(host, "login.microsoft.com")) ||
        (shExpMatch(host, "login.windows.net")) ||
        // IP Test Page
        (shExpMatch(host, "ipinfo.io"))) {
        return bypassproxy;
    }
    // =========================================================
    // Section 4: Default Traffic
    /* Default Traffic Forwarding. Forwarding to Zen on port 80, but you can use port 9400 also */
    return tozscaler;
}

"Show Configuration and Status" menu provide the values of CSC VIP and CSC Proxy Bypass:

The CSC has configured the PAC file for bypasses. 
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9.1 To Zscaler traffic test

9.1.1 Using a browser
➢ http://ip.zscaler.com test page.

NOTE: The page ip.zscaler.com doesn't provides the same information in all browsers. 

Using Edge: 

Using IE:
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➢ https://ip.maidenheadbridge.com test page.

9.1.2 Using Curl Command via CMD
Open CMD and run the following command:

> curl -s --proxy http://<CSC VIP>:80 http://ip.zscaler.com | findstr "You"

9.2 Bypass Traffic test

9.2.1 Using a Browser
Go to the bypassed domain: "ipinfo.io". You will see your local public IP. 
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9.2.2 Using Curl Command via CMD
Open CMD and run the following command:

> curl -s --proxy http://<CSC Bypass Proxy IP>:3128 http://ipinfo.io

9.3 Speed test
You can run "Speed Test" from the SSH Console of the CSC.  This test runs via the GRE tunnel 
active. 
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10 The Cloud Security Connector Admin Console:
The CSC's SSH Console simplifies administrative tasks showing what is essential to administrators 
for operation and troubleshooting.

Access to SSH Admin Console:  $ssh cscadmin@<CSC GW IP>

User: cscadmin  / Default Password: maidenheadbridge / IP to SSH <CSC GW IP>
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The Main Sections are:

• Monitoring Tasks: To check configuration, statuses, real-time traffic, tcpdump, traceroute 
and speed..

• CSC Admin Tasks: To register the CSC for AWS management, manage administrators, 
restrict SSH, configure radius, DNS, SNMP, NTP and time-zone.

• Proxy Bypass: View and configure Proxy Bypass (Layer 7) functionality.
• Routed Bypass:  View and configure Routed Bypass (Layer 4) functionality
• System and Traffic Logs: Shows Systems logs, configure Syslog Servers and enable/disable 

traffic logs.
• Configuration Wizards: Configure Zscaler Nodes, GRE Values and switch tunnels.
• Private Cloud Private Access (PriCPA): Show Configuration and Statuses, create Local 

Configuration, configure priCPA peers and add Remote Management Networks.
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10.1 Monitoring Tasks

10.1.1 Show Configuration and Status (TBC)
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10.1.1.1 GENERAL INFORMATION
This section contains general information about the CSC:

10.1.1.2 INTERFACES INFORMATION 
This section contains the interfaces information and you can check here is the Gateways, external 
and internal, are reachable. (Network Gateway is Alive)

10.1.1.3 TRAFFIC REDIRECTION Options.
The section contains information about how to steer traffic to Zscaler.

The following diagram shows the multiple options available: 

➢ See section "Traffic forwarding to Zscaler ZIA and Bypasses." for more details. 
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10.1.1.4 DNS INFORMATION
This section displays the DNS information. 

10.1.1.5 ZSCALER INFORMATION
This section shows the GRE tunnels IP information. 

10.1.1.6 TUNNEL STATUS
This section shows the Keepalives statuses and the Tunnel status. 

10.1.1.7 http://ip.zscaler.com INFORMATION
Zscaler recommends checking the page http://ip.zscaler.com to validate that you are using Zscaler 
and see Zscaler Node connected, Cloud and IP address.  The CSC does this test for you. 
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10.1.1.8 PROXY BYPASS
This section shows the Proxy Bypass Settings: Standard mode or Advanced mode. 

Standard mode:

Advanced mode:

10.1.1.9 ROUTED BYPASS
This section shows the configuration of Routed Bypasses and check if the routed bypass URL is 
reachable.

10.1.1.10 AWS SSM AGENT
This section shows the status of the AWS SSM Agent.

10.1.1.11 SYSLOG INFORMATION
When configured, this section will show the IP/s and TCP port of your Syslog/SIEM server and if 
Traffic Logs are enabled. (Note: Systems Logs are always enabled)
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All CSC's logs are tagged with (MHB-CSC)(<action>). The values of <action> are:

SystemLogs:

• UP

• DOWN

• INFO

• ALERT

• ERROR

Traffic Logs:

• ALLOW

• BLOCK

10.1.1.11.1 System Logs example:
To obtain your System Logs, you can search by CSC name plus the following TAG. For example:

Using GrayLog Server: source:zs\-csc\-mux\-4\-as\-d\-1 AND ("UP" OR "DOWN" OR "INFO" OR 
"ALERT" OR "ERROR")

10.1.1.11.2 Traffic Logs example:
Using GrayLog Server: source:zs\-csc\-mux\-4\-as\-d\-1 AND ("ALLOW" OR "BLOCK")
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10.1.1.12 HIGH AVAILABILITY Information
This section show all the information when the CSC is Cluster ACTIVE or  STAND BY. 
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10.1.2 Show Interfaces Traffic
Use this section to see the traffic in real time.

10.1.3 Tcpdump, Traceroute and Latency Test

10.1.3.1 Tcpdump
The objective of this test is to have detailed visibility of any type of traffic via any interface. 
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You can repeat the last command or running a new command. Example running a new command:

- Select the options:

- The test will show the resulting tcpdump command and will show the traffic captured. 
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10.1.3.2 Traceroute and Latency Test
This test can validate the quality of the Internet path between your location and Zscaler Nodes. 
You can run it with tunnels down or up. When the tunnels are up, it does a “Reverse Path” test 
from your active Zscaler node to your location. This test is beneficial to check if there is any packet 
loss at some point.

10.1.4 SPEED TEST
This test is experimental because we use third-party tools (speedtest.net), but it works fine in most
cases. 

Note:  Using GRE tunnels you can reach up to 3 Gbps to Zscaler.  
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10.2 CSC Admin Tasks

10.2.1 AWS SSM Agent (Register or De-Register)
The CSC AWS has installed the AWS SSM Agent that allows you to check remotely the status of the 
CSC and “Run Commands” using AWS Systems Manager. You can manage all CSCs models17 using 
AWS Systems Manager.

Note: You can learn more about “Run Commands” on Appendix B

Steps to create a "Hybrid Activation" and "Register the CSC".

10.2.1.1 Create a "Hybrid Activation" from AWS console.
On your AWS Console, go to Services → Systems Manager → Node Management → Hybrid 
Activations and click "Create". Fill the values on shown below:

→ Click "Create Activation"

17 For Vmware, Hyper-V, KVM, Azure, Gcloud and AWS. 
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The values of Activation Code, Activation ID and Region are required to register the CSC. Keep this 
values on a safe place. 

10.2.1.2 Register the CSCs

10.2.1.3 View the Registered CSC on AWS Systems Manager
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10.2.2 Manage Administrators, Restrict SSH access and Radius 
Configuration
IMPORTANT: This section can be accessed only by the "cscadmin" user. 

10.2.2.1 Manage Administrators: cscadmin and csccli
The CSC Mux for AZure has 2 users configured: cscadmin (for SSH Administrator Console Access), 
csccli (standard user, disabled by default.).

From this menu, you can edit the SSH Keys or Password.  

Note: the user "cscadmin" cannot be disabled. 

10.2.2.1.1 "cscadmin" settings
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10.2.2.1.2 "csccli" settings
Note: the "csccli" user allows console access to the CSC. If you are managing the CSC using 
Rundeck, or Ansible, you will need to enabled the "csccli" user and to setup the SSH Key.  

10.2.2.1.3 Managing the SSH Key of a User
You can add/remove keys for a User using "nano editor" when selecting the user from the previous
menu.

10.2.2.2 Restrict SSH Access
This functionality allows adminsitrators to restrict SSH access to the CSC. You can setup restrictions
for the Internal (eth1) and the PriCPA (wg0) interface. SSH to external (eth0) interface is always 
blocked. 

IMPORTANT (1): DEFAULT VALUES.
     -> Internal Interface (eth1): SSH the CSC to CSC GW IP (<IP>) is allowed from any Host or Subnet.
     -> External Interface (eth0): SSH the CSC to any eth0 IP is permanently blocked and cannot be changed.
     -> PriCPA Interface (wg0): SSH the CSC to wg0 IP (<IP>) is allowed from any other PriCPA node that belongs to the 
PriCPA Subnet. (<Subnet>/<Bitmask>)
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IMPORTANT (2): If the Host or Subnet is reachable via PriCPA interface and not Internal Interface eth1, you must add 
these Hosts or Subnets as Management Networks on PriCPA configuration.

Example of configuration:
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10.2.2.3 Radius Configuration
This functionality enables Radius Authentication for users accessing the Admin Console. The 
configuration requires the Radius Server IP and Secret. Optionally, you can add a secondary radius 
server as backup.

-> Configuration on the CSC: Add Radius Server and User:

-> Example Configuration Windows NPS

1 - Create Network Policy

In this particular case we are allowing users on the Security Group = Radius Users to authenticate 
using radius protocol. Please, note the Authentication method required.
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2 - Add the CSC as Radius Clients:

Note: The traffic will arrive to the NPS with source IP: CSC GW IP

 

Maidenhead Bridge CSC GRE for Zscaler - Virtual Platforms  | 68



10.2.3 Configure DNS, SNMP, NTP and Timezone.

10.2.3.1 DNS

10.2.3.2 SNMP 
The CSC uses Ubuntu Server as its OS and offers all SNMP values of a standard Ubuntu Server. The 
CSC supports SNMP v2c or v3. No special MIBs are required.

SNMP Traps are not supported. For information about tunnels up/down and other changes, please,
use Systems Logs to trigger alarms or events. 

10.2.3.2.1 Configure SNMP attributes
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10.2.3.2.2 SNMP v2c configuration
SNMP version 2c requires the "read only community" and the IP or Subnet of the SNMP platform.

In this example, our SNMP server has IP: 172.19.0.8/32 and the rocommunity is "public".

10.2.3.2.3 SNMP Networks
The CSC blocks all SNMP request by default. You need to enable the source IPs (or Subnets) that 
will query the CSC using SNMP. This setting is mandatory for SNMP v2c and v3.
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10.2.3.2.4 SNMP v3 configuration 
SNMP attributes and Networks are standard settings of SNMP v2c and SNMP v3. This section will 
show the specific values required for SNMP v3.

1. Security Name (or UserName) : <string>

2. Security Level: noAuthNoPriv|authNoPriv|authPriv

3. Authentication Passphrase: <string>

4. Authentication Protocol: MD5|SHA|SHA-512|SHA-384|SHA-256|SHA-224

5. Privacy Passphrase: <string>

6. Privacy Protocol: DES|AES
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10.2.3.2.5 What can you do with SNMP?
Here some examples of monitoring the CSC Mux via SNMP, using OpenNMS.

10.2.3.2.5.1 Node Information

10.2.3.2.5.2 Node Availability
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10.2.3.2.5.3 Node Interfaces (IP & SNMP)

10.2.3.2.5.4 Node Statistics (CPU, Memory, etc)
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10.2.3.2.5.5 Interfaces Traffic
You can see the traffic per physical interfaces (eth0, eth1), tunnel interfaces (tunx), and PriCPA 
interface (wg0).

Example of real time traffic on PriCPA interface:
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10.2.3.3 NTP
By default, the CSC PriCPA uses "ntp.ubuntu.com".  You can configure here your NTP Servers.

Check the Status:

The NTP Server connects correctly when the Status is: "Initial synchronization to time server 
xxxx".

10.2.3.4 Time Zone
Use this menu to select the timezone of the CSC. 

WARNING: Some SIEM/SYSLOG software will show the logs in the past or future if the Time Zone 
is incorrect. In most circumstances, UTC is the best choice.
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10.3 Proxy Bypass

There are two main modes of Proxy Bypass: Standard and Advanced. The default behaviour of 
Standard mode is to block all domains that are not on the bypass list. In contrast, the default 
behaviour of Advanced mode is to send all domains to Zscaler (upstream proxy) that are not on the
bypass list.

See Chapter "Traffic forwarding to Zscaler ZIA and Bypasses." for a detailed explanation of different
use cases.

10.3.1 Standard Mode

10.3.1.1 Network Diagram

10.3.1.2 Configuration using PAC file
➢ Select "Configure Standard Mode"

➢ Select method: PAC URL 
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10.3.1.3 Manual Configuration.
If you want to update manually your Proxy Bypass list, follow this steps.

1. Select Option 2)

2. Input "y"
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3. Add / Delete / Modify your full domains and subdomains

4. Please, CTL+X and "Yes" (and after next prompt Enter) to Save

5. The modified Bypass List will be displayed. 

6. Apply Changes Yes or No. If "1" you will receive the following message:
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10.3.1.4 "View Current Proxy Bypass List"
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10.3.2 Advanced Mode

10.3.2.1 Network Diagram

10.3.2.2 Configuration using JSON URL
➢ Change from Standard to Advanced Mode

➢ Select your Zscaler Cloud and Nodes. (Primary and Secondary.)
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➢ Configure Proxy Bypass JSON  file URL

Proxy Bypass JSON file URL example

{
  "model": "csc-gre-zs-vm",
  "type": "proxyBypassAdvanced",
  "version": "1.0",
  "help": ".domain.com matches domain.com and any subdomain of <>.domain.com. Do not use asterisk '*'",
  "proxyBypassRules": {
    "internalSites": [
      ".domainInternal.com",
      "fqdn-internal.com"
    ],
    "externalSites": [
      ".externalDomain.com",
      "fqdn-external.com",
      "ip.maidenheadbridge.com",
      "ipinfo.io"
    ]
  }
}

 

➢ Review and Apply values
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10.3.2.3 Configuration pasting JSON file
➢ Go to 9) Configure Proxy Bypass ->  3) Configure Advanced Mode ->  Select No to change 

the Zscaler nodes -> Internal and External Bypass Configuration -> Manual

➢ Review and Apply the configuration.
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10.3.2.4 "View Current Proxy Bypass List"
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10.4 Routed Bypass
When routing all traffic via the CSC GW IP, the Routed Bypass functionality allows you to connect 
specific destinations (IP/Subnet) direct to the Internet using your Public IP. By default, all 
destinations will travel via the tunnels to Zscaler. If you want to bypass the tunnel, you need to 
create a Routed Bypass Rule.

10.4.1 Routed Bypass - Traffic Flow

10.4.2 View Current Routed Bypass List
You can select to view the Routed Bypass Rules in Compact format or JSON. 
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10.4.2.1 Compact

10.4.2.2 Json
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10.4.3 Configure Routed Bypass List
There are two methods to configure the Routed Bypass List: Routed Bypass URL and Manual. The 
recommended method is to use Routed Bypass URL. 

10.4.3.1 Routed Bypass URL
Routed Bypass URL is the recommended method. Create an AWS bucket or Azure Blob and place 
your JSON file on it. Here an example:  
https://mhb-csc-pac.s3.amazonaws.com/routedBypassRulesFile.json
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10.4.3.2 Manual (Paste Routed Bypass JSON file)
Another option to configure Routed Bypass Rules is to paste the JSON file using the following 
menu:

and paste the JSON file. The JSON file will be displayed, and if no errors are found, you can apply 
the changes:
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10.5 System and Traffic Logs
In this section you can view System Logs, configure Syslog Servers and enable/disable traffic logs. 

10.5.1 View System Logs

10.5.2 Configure Syslog and Traffic Logs
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10.6 Configuration Wizards 
In this section, you can run the Configuration Wizard to change Zscaler Nodes and GRE values. It 
also provides a simple way to Switch tunnels.

10.6.1 Configure Zscaler Nodes and GRE values.
This wizard allows you to change the current values configured. The initial screen shows the values 
required. Please see the section "Creating the CSC GRE Cluster" for detailed information about 
creating the values of "Static IP", "GRE tunnel", and "Location."

➢ Initial screen.

➢ Configuring values
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➢ Confirm values (the CSC will reboot)

10.6.2 Switch Tunnels - Primary / Secondary.
This Wizard allows to Switch Tunnels Primary to Secondary and vice-versa. 
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11 Private Cloud Private Access

11.1 What is Private Cloud Private Access (PriCPA)?
Private Cloud Private Access (PriCPA) is a new functionality of the Cloud Security Connector. PriCPA 
allows you to create a Private Cloud among all CSCs for private traffic. In a matter of minutes, you 
can build a full mesh encrypted topology between your locations for private traffic with Zero Trust. 
After making the Private Cloud, you can set up your policies to define who will talk with who inside
your Private Cloud. 

11.2 PriCPA Network Diagrams

11.2.1 High Level Network Diagram
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11.2.2 Low Level Network Diagram – PriCPA only
The following network diagram shows the IP addressing for PriCPA.

Steps to design your Private Cloud:

1. Select a Subnet for your Private Cloud. The example above is 192.168.7.0/24. Due to the 
Subnet is /24, up to 255 CSCs can participate in this Private Cloud.

2. Assign a Cloud Private IP to each CSC. In this example, we are assigning 192.168.7.1 to 
192.168.7.4

3. The Public IP to be used will be the same assigned to the Bypass of each CSC. You can 
choose the UDP port to use at each location. For simplicity, it is recommended to use the 
same port at all locations. 

4. Gather the information of the private Subnets behind each CSC. This information will be 
required when configuring the Peers.

5. Firewall Rules (or Security Groups Rules): The CSC for Azure, AWS and Gcloud will 
implement the firewall rules automatically. Manual FW rules are required when the CSC is 
"On-Premises". The CSC provides a JSON file with the rules required. 
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11.3 Configuring PriCPA
The Main Menu has a section for Private Access:

In a few simple steps, you can configure PriCPA:

1. Create the Local Node configuration. This step will initialize and enable Private Access on 
the Node. The result of this operation will show a "Token" and "Private Access Local JSON 
file". 

2. Initialize the second Node of the HA pair using the "Token" and "Private Access Local JSON 
file".

3. Create and distribute the Private Access Peers JSON file to all nodes.

IMPORTANT: We strongly recommend using software with a JSON formatter to create the Peers 
JSON file, like Visual Code or Notepad ++ . See Appendix C for more detail about how to install 
these programs and the plugins required.

11.3.1 Create the Local configuration (First node of the HA pair)

➢ From Main Menu, select "18) Configure Private Access."

➢ Select "1) Create (or change) Private Access Local Configuration"
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➢ Select "1) Manual Configuration" and input the values requested. 

➢ Apply values

IMPORTANT: The "Token" and "Private Access Local Config JSON file" will be used to create the 
local configuration on the second node of the HA pair. Please, keep these values in a safe place. 
You can use these values to reconfigure any node of the HA Pair if necessary in the future. For 
example, if you want to change the IPs or descriptions.

11.3.2 Create the Local configuration (second node of HA Pair)
SSH the second node of the HA Pair and input the "Token" and "Private Access Local Config JSON 
file".

Go to 18) Configure Private Access. → 1) Create (or change) Private Access Local Configuration → 
2) Token and JSON
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11.3.3 Create the Private Access Peers JSON file
The Private Access Peers JSON file contains:

1. The Local configuration of each Peer.

2. The "backupPublicIPs" (used when you two or more uplinks to the internet)

3. The "networks" behind each Peer.

4. The "privateApps" allowed to be reached on each Peer.

Here some examples. 

11.3.3.1 Full mesh Private Access Peers JSON file
 Consider the following example: 

We have 3 nodes and we want to allow full communication between sites for all port and 
protocols. 

The Local Config JSON file of each node is:

ns-cgc00001

{
    "peers": [
        {
            "nodeName": "ns-cgc00001",
            "description": "Node on VMware Server 1",
            "location": "HQ",
            "publicKey": "yAnz5TF+lXXJte14tji3zlMNq+hd2rYUIgJBgB3fBmk=",
            "publicIpAndUdpPort": "200.1.1.1:51821",
            "privateCirdIp": "192.168.7.1/24",
            "persistentKeepAlive": "no",
            "backupPublicIPs": [],
            "networks": [],
            "privateApps": []
        }
    ]
}

 
ns-cgc00002

{
    "peers": [
        {
            "nodeName": "ns-cgc00002",
            "description": "Node on VMware Server 2",
            "location": "Datacentre 2",
            "publicKey": "xTIBA5rboUvnH4htodjb6e697QjLERt1NAB4mZqp8Dg=",
            "publicIpAndUdpPort": "200.1.1.2:51821",
            "privateCirdIp": "192.168.7.2/24",
            "persistentKeepAlive": "no",
            "backupPublicIPs": [],
            "networks": [],

Maidenhead Bridge CSC GRE for Zscaler - Virtual Platforms  | 97



            "privateApps": []
        }
    ]
}

ns-cgc00003

{
    "peers": [
        {
            "nodeName": "ns-cgc00003",
            "description": "Node on VMware Server 3",
            "location": "Branch",
            "publicKey": "TrMvSoP4jYQlY6RIzBgbssQqY3vxI2Pi+y71lOWWXX0=",
            "publicIpAndUdpPort": "200.1.1.3:51821",
            "privateCirdIp": "192.168.7.3/24",
            "persistentKeepAlive": "no",
            "backupPublicIPs": [],
            "networks": [],
            "privateApps": []
        }
    ]
}

Firstly, we need to create our "basic" Peers Configuration JSON file: It contains the Local 
Configuration of each Node plus the "networks" behind each node.

Basic Peers Configuration JSON file

{
    "peers": [
        {
            "nodeName": "ns-cgc00001",
            "description": "Node on VMware Server 1",
            "location": "HQ",
            "publicKey": "yAnz5TF+lXXJte14tji3zlMNq+hd2rYUIgJBgB3fBmk=",
            "publicIpAndUdpPort": "200.1.1.1:51821",
            "privateCirdIp": "192.168.7.1/24",
            "persistentKeepAlive": "no",
             "backupPublicIPs": [],
            "networks": [
                "10.1.1.0/24",
                "10.1.2.0/24"
            ],
            "privateApps": []
        },
        {
            "nodeName": "ns-cgc00002",
            "description": "Node on VMware Server 2",
            "location": "Datacentre 2",
            "publicKey": "xTIBA5rboUvnH4htodjb6e697QjLERt1NAB4mZqp8Dg=",
            "publicIpAndUdpPort": "200.1.1.2:51821",
            "privateCirdIp": "192.168.7.2/24",
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            "persistentKeepAlive": "no",
            "backupPublicIPs": [],
            "networks": [
                "10.2.1.0/24",
                "10.2.2.0/24"
            ],
            "privateApps": []
        },
        {
            "nodeName": "ns-cgc00003",
            "description": "Node on VMware Server 3",
            "location": "Branch",
            "publicKey": "TrMvSoP4jYQlY6RIzBgbssQqY3vxI2Pi+y71lOWWXX0=",
            "publicIpAndUdpPort": "200.1.1.3:51821",
            "privateCirdIp": "192.168.7.3/24",
            "persistentKeepAlive": "no",
            "backupPublicIPs": [],
            "networks": [
                "10.3.1.0/24",
                "10.3.2.0/24"
            ],
            "privateApps": []
        }
    ]
}

In this "Basic Peers Configuration JSON file" we have:

• Green: The Local values generated at each node, and "backupPublicIPs".
• Yellow: The Subnets behind each node
• Red: Nothing. No private Apps configured. 

If you deployed this "Basic Peers Configuration JSON file" to all CSCs, you have created the Private 
Cloud. All Peers will be visible to each other, but no traffic between subnets will be allowed 
because there is no "privateApps" configured.

If we want to allowed traffic any to any between subnets, we need to add the corresponding 
"privateApps" to each node. For example for node:  "ns-cgc00001"

ns-cgc00001

{
            "nodeName": "ns-cgc00001",
            "description": "Node on VMware Server 1",
            "location": "HQ",
            "publicKey": "yAnz5TF+lXXJte14tji3zlMNq+hd2rYUIgJBgB3fBmk=",
            "publicIpAndUdpPort": "200.1.1.1:51821",
            "privateCirdIp": "192.168.7.1/24",
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            "persistentKeepAlive": "no",
             "backupPublicIPs": [],
            "networks": [
                "10.1.1.0/24",
                "10.1.2.0/24"
            ],
            "privateApps": [
                {
                    "description": "Allow all traffic to this site",
                    "ipProtocol": "all",
                    "sourceCirdIp": [
                        "0.0.0.0/0"
                    ],
                    "destinationCirdIp": [
                        "10.1.1.0/24",
                        "10.1.2.0/24"
                    ],
                    "destinationSinglePorts": [
                        ""
                    ],
                    "destinationPortRange": {
                        "fromPort": "",
                        "toPort": ""
                    }
                }
            ]
        },

In this case, we added a "privateApp" that allows any source IPs (0.0.0.0/0) to reach the 
"networks" (10.1.1.0/24 and 10.1.2.0/24) using "all" protocols ("ipProtocol" : "all".)

Now, completing our "Peers Configuration JSON file":

Full Mesh Peers Configuration JSON file. 
{
    "peers": [
        {
            "nodeName": "ns-cgc00001",
            "description": "Node on VMware Server 1",
            "location": "HQ",
            "publicKey": "yAnz5TF+lXXJte14tji3zlMNq+hd2rYUIgJBgB3fBmk=",
            "publicIpAndUdpPort": "200.1.1.1:51821",
            "privateCirdIp": "192.168.7.1/24",
            "persistentKeepAlive": "no",
            "backupPublicIPs": [],
            "networks": [
                "10.1.1.0/24",
                "10.1.2.0/24"
            ],
            "privateApps": [
                {
                    "description": "Allow all traffic to this site",
                    "ipProtocol": "all",
                    "sourceCirdIp": [
                        "0.0.0.0/0"
                    ],
                    "destinationCirdIp": [
                        "10.1.1.0/24",
                        "10.1.2.0/24"
                    ],
                    "destinationSinglePorts": [
                        ""
                    ],
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                    "destinationPortRange": {
                        "fromPort": "",
                        "toPort": ""
                    }
                }
            ]
        },
        {
            "nodeName": "ns-cgc00002",
            "description": "Node on VMware Server 2",
            "location": "Datacentre 2",
            "publicKey": "xTIBA5rboUvnH4htodjb6e697QjLERt1NAB4mZqp8Dg=",
            "publicIpAndUdpPort": "200.1.1.2:51821",
            "privateCirdIp": "192.168.7.2/24",
            "persistentKeepAlive": "no",
            "backupPublicIPs": [],
            "networks": [
                "10.2.1.0/24",
                "10.2.2.0/24"
            ],
            "privateApps": [
                {
                    "description": "Allow all traffic to this site",
                    "ipProtocol": "all",
                    "sourceCirdIp": [
                        "0.0.0.0/0"
                    ],
                    "destinationCirdIp": [
                        "10.2.1.0/24",
                        "10.2.2.0/24"
                    ],
                    "destinationSinglePorts": [
                        ""
                    ],
                    "destinationPortRange": {
                        "fromPort": "",
                        "toPort": ""
                    }
                }
            ]
        },
        {
            "nodeName": "ns-cgc00003",
            "description": "Node on VMware Server 3",
            "location": "Branch",
            "publicKey": "TrMvSoP4jYQlY6RIzBgbssQqY3vxI2Pi+y71lOWWXX0=",
            "publicIpAndUdpPort": "200.1.1.3:51821",
            "privateCirdIp": "192.168.7.3/24",
            "persistentKeepAlive": "no",
            "backupPublicIPs": [],
            "networks": [
                "10.3.1.0/24",
                "10.3.2.0/24"
            ],
            "privateApps": [
                {
                    "description": "Allow all traffic to this site",
                    "ipProtocol": "all",
                    "sourceCirdIp": [
                        "0.0.0.0/0"
                    ],
                    "destinationCirdIp": [
                        "10.3.1.0/24",
                        "10.3.2.0/24"
                    ],
                    "destinationSinglePorts": [
                        ""
                    ],
                    "destinationPortRange": {
                        "fromPort": "",
                        "toPort": ""
                    }
                }
            ]
        }
    ]
}

Done! Your task is to implement this JSON file on all CSCs and you will have full connectivity any to 
any for all protocols.
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11.3.3.2 Understanding "privateApps" configuration and values
Question 1: Where to configure the "privateApps"?

Only on the node that has the "destinationCirdIp": [], that belongs to its "networks". 

Example: I want to allow access to "destinationCirdIp": ["10.1.1.50/32"]. The rule must be created 
on node ns-cgc00001 that has "networks": ["10.1.1.0/24","10.1.2.0/24"]

Question 2 : What about the values to configure?

On "privateApps" section there are two types of values to input:

Accepts single value only -> ""

Accepts single or multiple values -> []

"privateApps": [
                {
                    "description": "",
                    "ipProtocol": "",
                    "sourceCirdIp": [],
                    "destinationCirdIp": [],
                    "destinationSinglePorts": [],
                    "destinationPortRange": {
                        "fromPort": "",
                        "toPort": ""
                    }
                }
            ]

Examples:

Single value (""):

"description": " Intranet Servers",
"ipProtocol": "tcp",

Single or Multiple values ([]): 

"sourceCirdIp": ["0.0.0.0/0"],

"destinationCirdIp": ["10.1.1.100/32", "10.1.2.100/32"],
"destinationSinglePorts": [ "80", "443" ],

The following table shows all fields and values accepted:
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Field Value Type Values to configure Example

"description": "", Single String "description": "Intranet Server Access",

"ipProtocol": "", Single tcp,udp,icmp or all "ipProtocol": "tcp",

"sourceCirdIp": [], Single or 
Multiple

Networks in the 
range of: 
10.0.0.0/8
172.16.0.0/12
192.168.0.0/16
and
0.0.0.0/0

"sourceCirdIp": [
    "10.2.1.0/24",
    "10.2.2.0/24",
    "10.3.1.0/24",
     "10.3.2.0/24"
  ],

"destinationCirdIp": [], Single or 
Multiple

Networks in the 
range of 18: 
10.0.0.0/8
172.16.0.0/12
192.168.0.0/16

"destinationCirdIp": [
    "10.1.1.100/32",
    "10.1.1.200/32"
  ],

"destinationSinglePorts": [], Single or 
Multiple

Single Port of the 
range 1 to 65535

 "destinationSinglePorts": [
    "80",
    "443"
 ],

"destinationPortRange": {
    "fromPort": "",
    "toPort": ""
}

Single Single Port of the 
range 1 to 65535

"destinationPortRange": {
    "fromPort": "3780",
     "toPort": "3784"
}

IMPORTANT: For PriCPA, 0.0.0.0/0 represent the private network segments: 10/8, 172.16/12, 
192.168/16 and not the entire internet addresses. 

18 The expected value here is a value that belongs to the "network" defined behind the CSC. For example, of the 
network behind the CSC is 10.1.1.0/24, any destination configured must belong to 10.1.1.0/24, like 10.1.1.100/32. 
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11.3.3.3 Example of "privateApps" for a Windows Domain controller
The following example shows how to create rules to allow access to your Domains Controllers.  

The port information was taken from this article: 

https://docs.microsoft.com/en-us/troubleshoot/windows-server/identity/config-firewall-for-ad-
domains-and-trusts

Example: Domain Controllers IPs: "10.2.1.100/32" and "10.2.2.100/32" on Node ns-cgc00002 of previous example

"privateApps": [
                {
                    "description": "Domain Controllers TCP",
                    "ipProtocol": "tcp",
                    "sourceCirdIp": [ "0.0.0.0/0" ],
                    "destinationCirdIp": [ "10.2.1.100/32", "10.2.2.100/32" ],
                    "destinationSinglePorts": [ "135", "464", "389", "636", "3268", "3269", "53", "88", "445" ],
                    "destinationPortRange": { "fromPort": "49152", "toPort": "65535" }
                },
                {
                    "description": "Domain Controllers UDP",
                    "ipProtocol": "udp",
                    "sourceCirdIp": [ "0.0.0.0/0" ],
                    "destinationCirdIp": [ "10.2.1.100/32", "10.2.2.100/32" ],
                    "destinationSinglePorts": [ "123", "464", "389", "53", "88" ],
                    "destinationPortRange": { "fromPort": "", "toPort": "" }
                },
                {
                    "description": "Domain Controllers Ping",
                    "ipProtocol": "icmp",
                    "sourceCirdIp": [ "0.0.0.0/0" ],
                    "destinationCirdIp": [ "10.2.1.100/32", "10.2.2.100/32" ],
                    "destinationSinglePorts": [],
                    "destinationPortRange": { "fromPort": "", "toPort": "" }
                }
            ]

11.3.3.4 Example of "privateApps" for Internal Web Server.
In this example, we are showing how to configure access to users on ns-cgc00001  to an Internal 
Web server located behind node Node ns-cgc00003.

Example: Web Server "10.3.1.200/32" on Node ns-cgc00003 of previous example. Allow access to all users behind ns-cgc00001 

"privateApps": [
                {
                    "description": "Web Server 3",
                    "ipProtocol": "tcp",
                    "sourceCirdIp": [ "10.1.1.0/24", "10.1.2.0/24" ],
                    "destinationCirdIp": [ "10.3.1.200/32" ],
                    "destinationSinglePorts": [ "80", "443" ],
                    "destinationPortRange": { "fromPort": "", "toPort": "" }
                }
            ]
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11.3.4 Load the "Private Access Peers JSON file" to the CSCs.
After the Local Configuration is done and the "Private Access Peers JSON file" is created, the next 
task is to distribute and apply it on each CSC.

There are three methods available:

1. URL: (Recommended) Using "Private Access Peers URL" and running the command "Refresh
Private Access Peers URL" using AWS Systems Manager, Rundeck or Azure CLI commands.

2. DevOps: Distribute the JSON file on all CSC and run the command "Reload Private Access 
Peers URL" using AWS Systems Manager or Rundeck.

3. Manual: Copy/Paste the JSON file on each CSCs. 

In this section we are going to explain two methods: URL and Manual Copy. The DevOps method is 
explained on Section12: DevOps operations.

11.3.4.1 Using "Private Access Peers URL"
This is the recommended method. The steps to configure are:

1. Place the Private Access Peers JSON file on an internal web server or an AWS bucket19 or 
similar.  Obtain the download URL. 

Example of AWS bucket:

2. Configure the URL on each CSC.

Ssh the each CSC and go to Main Menu -> 18) Configure Private Access 

19 See Appendix D to learn how to secure an AWS S3 bucket by Source IP. 

Maidenhead Bridge CSC GRE for Zscaler - Virtual Platforms  | 105



At this moment, you have the option to review the privateApps to configure in Compact or JSON 
format and to apply the values. 
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3. The next time you want to refresh the Private Access Peers JSON file, update the file, 
deploy it on the same location URL and Run Command: "Refresh Private Access Peers URL" 
using AWS SSM Agent or Rundeck. 

AWS System Manager:

➢ Go to AWS Systems Manager -> Run Command -> and Select "MHB-CSC-Refresh-Private-
Access-Peers-URL"

➢ Move down the screen and select all CSCs:

➢ Go to the bottom of the page and click "Run". The next page shows the status of the 
command on each CSC.
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➢ To see the individual result, right click on the Instance ID and open it on a new TAB. Check 
the "Output"
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Using Rundeck

➢ Go to the Project <name> -> All Jobs -> Run " Refresh Private Access Peers URL"

➢  Select ALL nodes and click Run.

➢ Wait to succeeded. You can click on "command" to see the results node by node. 
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11.3.4.2 Manual: Copy and Paste "Private Access Peers Json file"
From Main Menu, go to 18) Configure Private Access, follow the steps below and Paste the Private 
Access Peers Json File:

Done!
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11.4 Show Configurations and Status Private Access.

11.4.1 Using SSH Admin console
From Main Menu, go to 17) Show Configurations and Status Private Access.

11.4.1.1 Show Peer/s Status
In this menu you can see "All Peers Status" or by peer "Select Peer". 

1. Show All Peers Status

IMPORTANT: This section show is the Peer is Alive and the "Source Port" that arrives at this node from the Peer. The 
Source Port information is essential to validate that the NAT on the Remote Peer is correct or if the FW on the other 
end is changing the Source Port. Please, correct the NAT on the remote Peer if you see that the Source Port differs 
from the expected.

2. Select Peer

This section shows a more detailed information about the Peer.

Maidenhead Bridge CSC GRE for Zscaler - Virtual Platforms  | 111



11.4.1.2 Show Peers Json file (active)
This menu shows the active Private Access Peers Json file.
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11.4.1.3 Show Local Configuration
This menu shows the Local configuration of the node. 

11.4.1.4 Show Firewall Local Rules
This menu shows in JSON format the Rules required on the Security Group of the external interface
of the CSC. 

Note: The CSC does the refresh of the External Security Group every time you update the Peers configuration. No 
manual configuration is required. 

Maidenhead Bridge CSC GRE for Zscaler - Virtual Platforms  | 114



11.4.2 Using AWS Systems Manager or Rundeck
In this case, the information provided is only "Show ALL Peer Status"

11.4.2.1 AWS Systems Manager
Go to AWS Systems Manager and Run Command: "MHB-CSC-Show-Private-Access-ALL-Peers-
Status" and select the Nodes. The result will show:

11.4.2.2 Rundeck
On Rundeck, run Job: "Show Private Access ALL Peers Status". Select the nodes. The output will 
show:
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11.5 Configure CSC Remote Management via Private Access.
When the CSC is in HA pair, only the active node belongs to the Private Cloud. For this reason, if 
you want to reach "the Other CSC" node using SSH, you must configure Remote Management on 
both CSCs of the HA pair.

The configuration is via SSH Main Menu. You need to add the "Management Networks". For 
example, in your primary Datacentre, you have the Subnet 172.19.0.0/24, and from that Subnet, 
you want to reach ALL CSCs on the Private Cloud.

The configuration will be:
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12 Remote Management
You can use several tools to Remote Manage the CSC. In this chapter, we are showing how to use 
AWS Systems Manager (Fleet Manager) and Rundeck. 

Both AWS Systems Manager and Rundeck can "Run Commands". If you want to use another 
system, here is the commands table with the tests and commands to run.

Commands table

Test # Descritption CSC Command

1 MHB-CSC-ShowConfigurationAndStatus /home/cscadmin/aws-mt4

2 MHB-CSC-SpeedTest /home/cscadmin/aws-mt7

3 MHB-CSC-TraceRouteAndLatencyTest /home/cscadmin/aws-mt6

4 MHB-CSC-Refresh-Proxy-Bypass-URL /home/cscadmin/aws-bp-refresh-list

5 MHB-CSC-ShowLogCurrentMonth /home/cscadmin/aws-l-current-month

6 MHB-CSC-Refresh-Routed-Bypass-URL /home/cscadmin/aws-refresh-routed-bypass-url

7 MHB-CSC-ShowLogLastSixMonths /home/cscadmin/aws-l-last-6-months

8 MHB-CSC-SwitchTunnels /home/cscadmin/aws-tun-switch

9 MHB-CSC-Reload-High-Availability /home/cscadmin/aws-reload-high-availability-json

10 MHB-CSC-Reload-Routed-Bypass-json /home/cscadmin/aws-reload-routed-bypass-json

11 MHB-CSC-Refresh-Private-Access-Peers-URL /home/cscadmin/aws-refresh-private-access-peers-url

12 MHB-CSC-Reload-Private-Access-JSON-file /home/cscadmin/aws-reload-private-access-peers-json

13 MHB-CSC-Show-Private-Access-ALL-Peers-Status /home/cscadmin/aws-show-private-access-all-peers-status

14 MHB-CSC-Update-Nodes-Database /home/cscadmin/aws-node-region-update
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12.1 AWS Systems Manager
The easiest and accessible way to manage the Cloud Security Connectors is to use AWS Systems 
Manager. AWS official documentation is available here: https://aws.amazon.com/systems-
manager/. The CSC has preinstalled the SSM Agent. You need to register the CSC using "Hybrid 
Activations" and "Run Documents" afterwards.

With AWS Systems Manager, you can manage the CSC remotely. To do it, you need to create 
"Documents" in advance. "Documents" are a series of commands used by the "Run Command" 
functionality.
This section explains how to create the "Documents" and "Run Commands".

12.1.1 Create Documents
We provide a CloudFormation template to create all "Documents" in one shot. 

Steps:

1. Download the CloudFormation template from: 

https://maidenheadbridge.freshdesk.com/support/solutions/articles/33000280930-create-
documents-to-manage-the-csc-via-aws-systems-manager

2. Deploy Stack. Go to Cloudformation →Create Stack→ Upload a template file

3. Click next. 

4. Put the Stack Name
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5. Click Next -> Next -> Create Stack. 

6. Wait the Stack to complete. 

7. Now go to Services -> Systems Manager -> and click "Documents" and choose "Owned by 
me"

 

8. Done!

12.1.2 Run Commands
After you have created the Documents, you are ready to Run Commands on the CSC.
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You can see the operation results on the "Output" section or store the results on S3 Buckets for 
further inspection.

To "Run Commands", go to AWS Systems Manager → Instances & Nodes → Run Command.

Here is an example of Running: MHB-CSC-ShowConfigurationAndStatus

1. Run a Command

2. Select the Document created (Tip: Select "Owned by me")

3. Scroll down and Select the Instances
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4. Click "Run" . Wait for the Command Status "success" 

5. Right click on Instance ID (mi-xxxx) and open in new tab. Check Output.
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6. Done! (Note: You can copy the output and to display on a text editor for more visibility)
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12.1.3 List of Documents available for "Run Command" 
1. "MHB-CSC-ShowConfigurationAndStatus": Executes "Show Configuration and Status"

2. "MHB-CSC-SpeedTest": Performs speedtest.net on the CSC.

3. "MHB-CSC-TraceRouteAndLatencyTest": Performs MyTraceRoute test against the Primary 
and Secondary ZEN. It also does a Reverse Test from the tunnel active to your Public IP if 
the tunnel is up. 

4. "MHB-CSC-Refresh-Proxy-Bypass-URL": Refresh the Proxy Bypass list using the values of the
Proxy Bypass PAC file stored in the URL configured. 

5. "MHB-CSC-Refresh-Routed-Bypass-URL": Refresh the Routed Bypass list using the values of 
the JSON file stored in the URL configured. 

6. "MHB-CSC-ShowLogCurrentMonth": Shows current month logs. 

7. "MHB-CSC-ShowLogLastSixMonths": Shows last six month logs. 

8. "MHB-CSC-SwitchTunnels": Switch tunnels. 

9. "MHB-CSC-Reload-Config-json": Reloads the values of config.json file. (not implemented on
the CSC Mux for Azure)

10. "MHB-CSC-Reload-High-Availability": Reloads the values of highAvailability.json file. (for CSC
on AWS, Azure and Gcloud. Not in use on CSC for Virtual Platforms. 

11. "MHB-CSC-Reload-Routed-Bypass-json": Reloads the values of routedBypassRulesFile.json.

12. "MHB-CSC-Update-Nodes-Database": Updates the Zscaler Node Database.

13. "MHB - CSC - Refresh Private Access Peers URL": Refresh the Private Access Peers list using 
the values of the JSON file stored in the URL configured.

14. "MHB - CSC - Reload Private Access Peers JSON file":  Reloads the values of 
privateAccessPeersConfig.json

15. "MHB - CSC - Show Private Access ALL Peers status": Show the Status of all Private Access 
Peers.
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12.2 Rundeck
Rundeck (https://www.rundeck.com/) is an open-source software Job scheduler and Run Book 
Automation system for automating routine processes across development and production 
environments. It combines task scheduling multi-node command execution workflow orchestration
and logs everything that happens.

Installation Steps:

1. Install Rundeck. Intructions at: https://www.rundeck.com/open-source

2. Create a Project.

3. Enable user "csccli" and setup the SSH Public key on each CSC. 

4. On the Project, setup the SSH Private and define the nodes:

5. Create the jobs. Please, contact Support at http://support.maidenheadbridge.com for the 
latest Job List. 
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12.2.1 Jobs
The following screen shows the list of Jobs available. 

12.2.2 Running job "Show Configuration and Status"
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13 DevOps operations
The CSC is delivered will all configurations and is ready for production. Even so, during the life cycle
of the CSC, some parametrization may be required to be changed or modified. For this reason, we 
provide some configuration utilities that will help with further parametrization and change 
management.

The CSC offers an option to do some changes using JSON config files. The operation is simple and is
three steps:

1. Obtain the current JSON file from the CSC.

2. Download the modified JSON file to the CSC.

3. "Run Command" (AWS Systems Manager) of the specific "reload" document. (or use 
Rundeck Job or Azure Run Command)

The JSON files are available are:

1. routedBypassRulesFile.json: Allows administrators to manually configure Routed Bypass 
Rules if not using the Routed Bypass URL method.

2. privateAccessPeersConfig.json: Use this Json file to configure "networks" and 
"privateApps" on your Private Cloud. 

In this chapter, we are going to explain the procedures.
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13.1 routedBypassRulesFile.json
You can use this file to create Routed Bypass Rules manually instead of using the automatic 
method via Routed Bypass URL.

1. Obtain the current "routedBypassRulesFile.json" from the CSC, running "Run Command" 
(AWS-RunShellScript.). For example:

cat /usr/local/etc/mhb-csc/routedBypassRulesFile.json

{
    "routedBypassRules": [
        {
            "description": "O365 Login URLs 1",
            "ipProtocol": "tcp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "20.190.128.0/18",
            "fromPort": "80",
            "toPort": "80"
        },
        {
            "description": "O365 Login URLs 2",
            "ipProtocol": "tcp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "20.190.128.0/18",
            "fromPort": "443",
            "toPort": "443"
        },
        {
            "description": "O365 Login URLs 3",
            "ipProtocol": "tcp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "40.126.0.0/18",
            "fromPort": "80",
            "toPort": "80"
        },
        {
            "description": "portquiz.net",
            "ipProtocol": "tcp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "52.47.209.216/32",
            "fromPort": "80",
            "toPort": "80"
        },
        {
            "description": "O365 Login URLs 4",
            "ipProtocol": "tcp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "40.126.0.0/18",
            "fromPort": "443",
            "toPort": "443"
        },
        {
            "description": "Skype and Teams UDP 1",
            "ipProtocol": "udp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "13.107.64.0/18",
            "fromPort": "3478",
            "toPort": "3481"
        },
        {
            "description": "Skype and Teams UDP 2",
            "ipProtocol": "udp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "52.112.0.0/14",
            "fromPort": "3478",
            "toPort": "3481"
        },
        {
            "description": "Skype and Teams UDP 3",
            "ipProtocol": "udp",
            "sourceCirdIp": "0.0.0.0/0",
            "destinationCirdIp": "52.120.0.0/14",
            "fromPort": "3478",
            "toPort": "3481"
        }
    ]
}
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2. Create a AWS bucket (or other place) and place on it the modified 
"routedBypassRulesFile.json" file. 

3. Download the file to the CSC. Run Command "AWS-RunShellScript" 

wget <Your bucket file URL> -O /usr/local/etc/mhb-csc/routedBypassRulesFile.json

4. Run Document "MHB-CSC-Reload-Routed-Bypass-json" to apply the changes. 
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13.2 privateAccessPeersConfig.json
You can use this file to create Private Access Peer Rules manually instead of using the automatic 
method via Private Access Peers URL.

1. Obtain the current "privateAccessPeersConfig.json" from the CSC, running "Run Command"
(AWS-RunShellScript.). For example:

cat /usr/local/etc/mhb-csc/privateAccessPeersConfig.json

{
    "peers": [
        {
            "nodeName": "ns-cgc00001",
            "description": "Node on VMware Server 1",
            "location": "HQ",
            "publicKey": "yAnz5TF+lXXJte14tji3zlMNq+hd2rYUIgJBgB3fBmk=",
            "publicIpAndUdpPort": "200.1.1.1:51821",
            "privateCirdIp": "192.168.7.1/24",
            "persistentKeepAlive": "no",
            "backupPublicIPs": [],
            "networks": ["10.1.1.0/24", "10.1.2.0/24" ],
            "privateApps": [
                {
                    "description": "Allow all traffic to this site",
                    "ipProtocol": "all",
                    "sourceCirdIp": [ "0.0.0.0/0" ],
                    "destinationCirdIp": [ "10.1.1.0/24", "10.1.2.0/24" ],
                    "destinationSinglePorts": [ "" ],
                    "destinationPortRange": {  "fromPort": "", "toPort": "" }
                }
            ]
        },
        {
            "nodeName": "ns-cgc00002",
            "description": "Node on VMware Server 2",
            "location": "Datacentre 2",
            "publicKey": "xTIBA5rboUvnH4htodjb6e697QjLERt1NAB4mZqp8Dg=",
            "publicIpAndUdpPort": "200.1.1.2:51821",
            "privateCirdIp": "192.168.7.2/24",
            "persistentKeepAlive": "no",
            "backupPublicIPs": [],
            "networks": [ "10.2.1.0/24",  "10.2.2.0/24" ],
            "privateApps": [
                {
                    "description": "Allow all traffic to this site",
                    "ipProtocol": "all",
                    "sourceCirdIp": [ "0.0.0.0/0" ],
                    "destinationCirdIp": [ "10.2.1.0/24", "10.2.2.0/24" ],
                    "destinationSinglePorts": [ "" ],
                    "destinationPortRange": {  "fromPort": "",  "toPort": "" }
                }
            ]
        },
        {
            "nodeName": "ns-cgc00003",
            "description": "Node on VMware Server 3",
            "location": "Branch",
            "publicKey": "TrMvSoP4jYQlY6RIzBgbssQqY3vxI2Pi+y71lOWWXX0=",
            "publicIpAndUdpPort": "200.1.1.3:51821",
            "privateCirdIp": "192.168.7.3/24",
            "persistentKeepAlive": "no",
            "backupPublicIPs": [],
            "networks": [ "10.3.1.0/24", "10.3.2.0/24" ],
            "privateApps": [
                {
                    "description": "Allow all traffic to this site",
                    "ipProtocol": "all",
                    "sourceCirdIp": [ "0.0.0.0/0" ],
                    "destinationCirdIp": [ "10.3.1.0/24", "10.3.2.0/24" ],
                    "destinationSinglePorts": [ "" ],
                    "destinationPortRange": { "fromPort": "",  "toPort": "" }
                }
            ]
        }
    ]
}
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2. Create a AWS bucket and place on it the modified "privateAccessPeersConfig.json" file. 

3. Download the file to the CSC. Run Command "AWS-RunShellScript" 

wget <Your bucket file URL> -O /usr/local/etc/mhb-csc/privateAccessPeersConfig.json

4. Run Document "MHB-CSC-Reload-Private-Access-JSON-file" to apply the changes. 
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14 Appendixes

14.1 Appendix A: Release Notes

14.1.1 Version 4.1.0
Version 4.1.0 comes with the following enhancements:

• New! Multiple uplinks are supported. In this version, you can define multiple uplink IPs that
can be public or private. This functionality provides multiple uplink redundancy via multiple
ISPs or Private Networks (e.g., MPLS). 

• New! Introducing a new feature that's as easy to use as powerful. You can now create a 
PriCPA cloud within your private networks. For instance, you can use MPLS to transport the 
PriCPA cloud. This functionality empowers you to encrypt and add zero trust to an MPLS 
network, all with a few simple steps.

• Other: Minor bug fixes and cosmetic changes.

14.1.2 Version 4.0.5
Version 4.0.5 comes with the following enhancements:

• New! Private Cloud Private Access: PriCPA is a unique functionality of the Cloud Security 
Connector. PriCPA allows you to create a Private Cloud among all CSCs for private traffic. In 
a matter of minutes, you can build a full mesh encrypted topology between your locations 
for private traffic with Zero Trust. After making the Private Cloud, you can set up your 
policies to define who will talk with whom inside your Private Cloud. 

• New! Proxy Bypass Advanced Mode: This functionality was created for servers and devices 
with Explicit Proxy settings. It provides connectivity to Zscaler (upstream Proxy), DIRECT via 
local public IP and also connectivity to internal websites. 

• New! Traffic Logs: The CSC can send all traffic logs to a Syslog/SIEM server. The Traffic Logs 
provide visibility of all IP communications to Zscaler, Routed and Proxy Bypasses, PriCPA, 
and Local received and generated traffic. This functionality is essential to customers with a 
basic Zscaler Cloud Firewall license.

• New! SNMP support: The CSC can be monitored via SNMP v2c and v3. 
• New! Radius integration: You can access the Admin console using your username and 

authenticating via Radius protocol to a Radius Server. 
• New! The "csccli" user can be enabled and configured via the Admin console, allowing 

terminal access to the CSC using SSH keys.
• New! SSH access can be restricted per Subnet or IP. It applies to the CSC's Internal (eth1) 

and PriCPA interface. It is not required anymore to set up external security groups. 
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• New! TCPdump functionality is provided via the Admin console for easy troubleshooting of 
IP traffic. 

• Base OS upgraded to Ubuntu 22.04

14.1.3 Version 2.6
Version 2.6 comes with the following enhancements:

• NEW! Configuration Wizard. It is possible now to change via SSH Console the following 
parameters: GRE credentials, DNS servers, Cloudname and Syslog servers.   

• NEW! Switch tunnels. It is possible now to switch Primary / Secondary via SSH console.

• Change: The default template of the OVA file requires 2 x CPU, 4 GB RAM, 8 GB disk. This 
increase was done due to the intensive use of the Bypass Proxy functionality by our 
customers.  If you are sending most of the traffic to via tunnels, you can reduce it to 1 x 
CPU, 1 GB RAM.

14.1.4 Version 2.5
Version 2.5 comes with the following enhancements:

• NEW! Zscaler Global Proxies accepted for Bypass Proxy (port :3128). Now, on the CSC, it is 
possible to use the Zscaler Global Proxies IPs (Ranges 185.46.212.88-93 and 185.46.212.97-
98) to redirect traffic to the CSC Bypass Proxy.  You need to point your bypass URLs to 
(example) : PROXY 185.46.212.88:3128 . This feature was requested by several customers in
order to create a unique global pac file using the Zscaler Global Proxies.

    • Some cosmetic menu changes. 

14.1.5 Version 2.3
Version 2.3 comes with the following enhancements:

• Logs to Syslog server. On version 2.3 you can setup one or two Syslog servers where to send
the information about Tunnel and Cluster.

• Menu Changes: Two new options added to see the last month logs or last 6 months. 

14.1.6 Version 2.2
Version 2.2 comes with the following enhancements:

• DNS Resolver timeout reduced  to improve response of time of Bypass Proxy when Primary 
DNS fails or is slow.

• Cosmetic changes on "Show Configuration and Status" menu. 
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14.1.7 Version 2.1
Version 2.1 comes with the following enhancements:

• Watchdog application added.  This watchdog will prevent any potential deviation behaviour
or memory leak of the process running on the CSCs.

• Bypass proxy allows tunnelling to non standard HTTPS ports. This was requested by several 
customers using Cloud Services like SAP. 

14.1.8 Version 2.0
Version 2.0 comes with the following enhancements:

• New! Bypass Proxy functionality : The Bypass Proxy solves the problem when is required to 
send traffic direct to internet and not via Zscaler ZEN nodes.The most common case is when
destination web site accepts only traffic coming from a specific public IP.Without the Bypass
Proxy, customers where obligated to have an internal proxy or to configure several firewall 
rules and routes to the destinations required to be bypassed.The Bypass Proxy simplifies 
this task: using the Zscaler PAC files servers as repository of your bypasses and automating 
the task with AWS, you can easily get up to date all your bypasses in all CSC instances.The 
Bypass Proxy acts as Web Firewall. It only allows to reach domains hosts defined by the 
Administrator.

• Resilient Algorithm: When returning to the Primary ZEN, Resilient Algorithm checks if the 
Primary ZEN was stable for 10 minutes before to change nodes.

• Timers: Timers were adjusted to better support locations with long delays (more than 250 
ms) to the ZEN Nodes.

• Internal IPs: The CSC GRE Cluster is using now five consecutive IPs for the Internal side. The 
first one is the Internal Cluster IP, the second the VIP Proxy, the third is the Bypass proxy, 
the fourth is the interface of the csc-gre-a and the fifth the csc-gre-a.

• External IPs: The CSC GRE Cluster is using now fourth consecutive IPs for the External side. 
The first one is the External Cluster IP, the second the Egress Bypass, the third is the 
interface of the csc-gre-a and the fourth the csc-gre-a.

• New! Monitoring Tasks Menu:  Traceroute and Latency Test. This Test does a MTR 
(MyTraceRoute) test to Primary & Secondary ZEN and Google DNS. In addition to this, if the
tunnel is UP, this test does a MTR test on Reverse from the Zscaler node active to your 
public IP. This test is similar than the one provided on the Zscaler Analyzer tool with the 
advantage that has the ability to analyse the reverse path as well.
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• New! Monitoring Tasks Menu:  Speed Test (Experimental). This test uses a third party tool: 
speedtest.net . This test provides the Ping delay, Download and Upload Speed.

• New! "Configuration and Status" Menu. Using this menu, in one shot you will retrieve 32 
configuration parameters and will do 16 status checks.

• New! AWS Management. Now, you can manage the CSC Anywhere from AWS as "Managed 
Instance"
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14.2 Appendix B: JSON formatters (Visual Code, Notepad ++)
We strongly recommend using Software that can show errors on your JSON file and also can format
(beautify) the file for better visibility. Below two examples.

14.2.1 Visual Code

1. Download : https://code.visualstudio.com/download

2. Select your platform and install. 

3. Create your JSON. 

3.1. Visual Code will show the errors in RED. 

3.2. To "Beautify" your JSON file press:

3.2.1. On Windows: "Shift + Alt + F"

3.2.2. On MAC: "Shift + Option + F"

3.2.3. On Linux: " Ctrl + Shift + I"
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14.2.2 Notepad ++

1. Download: https://notepad-plus-plus.org/downloads/

2. Install JSON Viewer Plug in.

3. Create your JSON file.

4. To Check your JSON file go to: Plugins -> JSON Viewer -> Show JSON Viewer.
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5. To format ("Beautify") your JSON go to: Plugins -> JSON Viewer -> Format JSON
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14.3 Appendix C: Securing an AWS Bucket by source IP.
1. On your AWS console create a bucket with default values for permissions: "Block all Public 

Access = on"

2. On Bucket Policy, add your Public IPs in "aws:SourceIp":[]

{
    "Version": "2012-10-17",
    "Id": "S3PolicyId1",
    "Statement": [
        {
            "Sid": "IPAllow",
            "Effect": "Allow",
            "Principal": "*",
            "Action": "s3:*",
            "Resource": "arn:aws:s3:::mhb-zscaler-private/*",
            "Condition": {
                "IpAddress": {
                    "aws:SourceIp": [
                        "200.1.1.1/32",
                        "200.1.1.2/32",
                        "200.2.0.0/24"
                    ]
                }
            }
        }
    ]
}

3. Done! 
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